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Overview

Overview

Table Data Manager was built to enable the management of tables and views in an Azure SQL
Database. A design environment facilitates the defining of tables and views. The separation
between the design environment and database implementation provides flexibility. Table and
view definitions can be copied between databases, along with data records between tables.
Active transactions can be reviewed to uncover possible locking/blocking issues between each
database environment.

Table Data Manager provides the following:
« Access to application or external database architecture.
« Ability to manipulate tables and views inside of a database.

« A solution for consultants to interact with the database for the delivery of customer-driven
solutions.

Access to Table Data Manager is limited to those with the System Administrator security role. This
should be strictly enforced because of accessibility to application information and controls.
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Getting Started

Getting Started

Use the following information to understand prerequisites and dependencies, plan your
installation, and configure the database server.

Note: Before beginning setup, verify that the SQL server has table creation rights on the
SQL database to create the custom tables.

Application Server Settings

You may need to edit the OneStream Application Server configuration so users can create and
change data in the additional database tables used by Table Data Manager. If other MarketPlace
Solutions are already in the application, these adjustments may already exist.

Configure the OneStream Application Server

Be sure that these security group settings include those who will be working on and setting up
Table Data Manager before you begin.

Note: Group settings are applicable to all Marketplace Solutions; it is important to keep the
group hames generic.

1. Start the OneStream Server Configuration Utility as an Administrator.
2. Select Open Application Server Configuration File > Database.

3. Editthe following OneStream Database Server properties:

Access Group for Ancillary Tables: Select a group that includes those who will access
records.

Can Create Ancillary Tables: True
Can Edit Ancillary Table Data:True

Maintenance Group for Ancillary Tables: Select a group who will edit and maintain
tables.

Table Creation Group for Ancillary Tables: Administrators
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OneStream Database Server properties:

x| 21 |
Azure Database Connection Settings
Connection String Settings

v  General
Access Group for Ancillary Tables |DB_AMI_Mcm_GmI.p I-l—
Allow Database Creation via Ul True
Can Create Ancillary Tables |True
Can Edit Ancillary Table Data True
Database Provider Type SqlServer
ls BEtemal Database False
Maintenance Group for Ancillary Tables DB_ANC_ Maintenance Group Ii—
Name OneStream Database Server
Table Creation Group for Ancillary Tables Everyone
Use File Groups when Creating Databases True
Use Table Partitioning when Creating Databases True

4. Restart Internet Information Server.

Install Table Data Manager

1. From the OneStream MarketPlace Dashboard, click MarketPlace > Table Data Manager.

2. Onthe Table Data Manager Solution page, select your OneStream platform version from
the Minimum Platform Version dropdown list.

This selection automatically displays the appropriate solution version in the next box.

3. Select the most recent version from the Solution Version dropdown list and then click
Download.

4. Loginto OneStream.
5. Onthe Application tab, click Tools > Load/Extract.

6. Onthe Load tab, locate the solution package using the Select File icons and click Open.
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7. When the solution’s file name appears, click Load.

8. Click Close to complete the installation.

Package Contents and Naming Conventions

The package filename contains multiple identifiers that correspond with the Platform. To preserve
the integrity of the naming conventions, renaming any of the elements contained in a package is
discouraged.

Example package name: TDM_PV6.2.0_SV100_PackageContents.zip

Identifier Description

TDM Solution ID

PV620 Minimum Platform version required to run solution
SV100 Solution version number

PackageContents | Filename

Software Dependencies

The following table describes software dependencies:

Component Description

OneStream 6.2.0 or | Minimum OneStream Platform version required to install this version of
later Table Data Manager.

Select the Table Data Manager Development
Location
Before you begin the installation, decide whether to build Table Data Manager directly in the

Production OneStream application or in a separate Development OneStream application. This
section provides some key considerations for each option.

Note: OneStream Software strongly recommends that you implement Table Data Manager
in the Development environment with a fresh copy of the Production application before
starting work.
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Development OneStream Application: As a best practice, use the Development OneStream
application to build Table Data Manager.

See Also: MarketPlace Solution Modification Considerations
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Solution Setup

Solution Setup

You need to set up tables for Table Data Manager.

1. Select Table Data Manager from OnePlace > Dashboards > Table Data Manager. This
takes you to the Table Data Manager Setup screen to create the required tables. After initial
setup, this is the default viewer when you click into Table Data Manager.

2. Click Setup Tables to create or update required solution tables.and select the feature you
need to create custom tables for (for example, Guided Reporting).

3. Click Launch Solution.

Note: Before running the setup, ensure that the account used to access SQL server has
table creation rights to the SQL database to create custom tables.
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Home

Home

N

-

The Home page contains the Database selection dropdown.

TABLE DATA MANAGER

HOME

Database
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Settings

Settings

The Settings page contains a Bl Blend section which has a list of External
databases you have to set up. You can select which of these databases you use as
your Bl Blend database in order to review Bl Blend statistics. It also contains
Uninstall options.

Bl Blend
Database

(s)

This type of database is a special database created to support the Bl Blend "read-
only" aggregate storage model which is accessed through the OneStream
Workflow. Table Data Manager reports upon additional statistics captured during
the creation of this database which can be found under Statistics. More than one
type of this database can exist and for Table Data Manager to know if this extra
data exists, the setting helps to determine which database selection will have the
information.

Table Data Manager Uninstall Options

Uninstall Ul removes Table Data Manager but leaves the related

—

data tables with records in place. Use this option if you want to
accept a Table Data Manager update without removing the data
tables. The Table Data Manager Release Notes will indicate if an
overinstall is supported.

any new version of Table Data Manager since some of the
Dashboard or other objects may have been renamed. Note that
some Global Options will also be cleared because their values are
stored in Parameters under Dashboards.

\\/ For some releases, this step should be performed before accepting

=

L

data tables and records. Use this option to completely remove Table

Data Manager or to perform an upgrade that is so significant in its
é::-\l:i}/g changes to the data tables that this method is required.

Q/ Uninstall Full removes Table Data Manager including the related
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Settings

[Caution: The Uninstall procedure cannot be reversed.
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Using Table Data Manager

Using Table Data Manager

Table Data Manager has several features to help you create, read, update, delete, tables and
views within OneStream Software.

TABLE DATA MANAGER

HOME

Database

Define Tables

Q7 @ @ N0 6 @ &2 ® iE E

Define Schema Upload Download | Data Import Export Remove | Activity Statistics | Create Alter  Drop | Revive  Copy
Identifier Description
Define Select a database where your XFC table or XFC view will reside. You can define
the metadata for an XFC table or XFC view from this button.
Schema Select any table or view to see its metadata. For example, you can see the
column name, data type, length, and other aspects of the table.
Select a database. Select the download file containing the metadata for your
Upload XFC table or XFC view. The file will be used to create a copy in the SQL
Database and the Definitions grid.
Select an XFC table or XFC View to download its metadata to a file. This file can
Download .
be used during the upload process.
Data Select any table or view to look at the data.
Import Select an XFC table to import the data from the export file.
Export Select an XFC table to export the selected data to a file.
Remove Removes data from the selected XFC table.
Activity Select database and click Activity to view Active and Blocked transactions.
Select a database, table or view group or individual table or view and click
Statistics Statistics to view the table and view record counts, or specific Bl Blend table
information.
Select an XFC table or XFC view and click Create to add its definition into the
Create
database.
Alter Select an XFC table or XFC view and click Alter to change its definition into the
database.
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Select an XFC table or XFC view and click Drop to remove its definition from the

Drop database.

Revive Select an XFC table and click Revive to restore its definitions from the database.

Select any table and click Copy to create a mirrored XFC table including data
Copy records into table definitions and the database. XFC will be automatically
appended as the table name prefix.

Defining a Table

The Define button allows you to construct a table using the options available in Table Data
Manager. The screenshot below shows the steps that correspond to the Defining a Table
procedure.

TABLE DATA MANAGER 2

HOME

Database Define Tables ® Table  View
> N A m O = N - o “
] H g8 ] n (x)
PR 2 @ @0 PO E ®2 @B B
Define Schema Upload Download | Data Impog Export Remove | Activity Statistics | Create Alter  Drop | Revive  Copy
BiBlendReporting_Web9 'o + =D Ha Table Definitions. l
4 BiBlendReporting Web9 Table Name T Table Description ¥ | Last Action ¥ | Last Change Y Last Change User ¥
4 XFC Tables XFC_MyFirstCustomTable 9 Table to hold custem data. Created 5/24/2021 8:45:40 PM  Mark Stobbelaar
XFC_MyFirstCustomTable XFC_MySecondCustomTable Extra table to hold custom data Created 5/24/2021 8:45:55 PM | Mark Stobbelaar
XFC_MySecondCustomTable XFC_VBIB_MarketPlace_QA_62_BIBlend_Administrationimport_Actual 2018M1 Copied 5/25/2021 12:47:00 PM | Mark Stobbelaar

XFC_vBIB_MarketPlace_QA_62_BlBlend_Administrationimport_Actual_2018M1
b Tables
b XFC Views

b Views

3 Rows. Page 1 of 1

+ =0 Hﬂ XFC_MyFirstCustomTable Column Definitions 6 =

ColumnName 7V DataType T |length T Scale ¥ Precision Y Allow Nulls ¥ |Default Y| PrimaryKey V SortOrder Y

MyFirstColumn Int 0 nnm 0

MySecondColumn  Varchar MAX Q (L] 0

1. Select a database.
2. Click Define. The table definitions are displayed in the right column.
3. Click the Plus from the menu.

4. Enter atable name and a table description for the table you want to edit.
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5. Click the Save.
6. Navigate to Column Definitions below Table Definitions.

Tables created within Table Data Manager have the prefix XFC. Table and column names can
contain letters, numbers, and underline characters only.

Note: Column definitions support the Int,Char, Varchar, Nvarchar, Bit, Bigint, Decimal,
Date, Datetime, Time, and Uniqueldentifer data types.

Defining a View

The Define button allows you to construct an XFC view using the options available in Table Data
Manager. The screenshot below shows the steps that correspond to the Defining a View
procedure.

TABLE DATA MANAGER ?
HOME
Database Define Views Table @ View

F@Q 7 @ @ B DO € @ |® 2 ®

Define Schema Upload Download | Data Import Export Remove | Activity Stafistics | Create Alter  Drop

giBlendReporting Webd - +=0OH View Definitions il

4 BiBlendReporting Web9 View Name Y View Description ¥ | Last Action ¥ | Last Change ¥ | Last Change User ¥
¥ XFC Tables XFC_vMyView First View Created 5/24/2021 8:47:40 PM

»  Tables XFC_vMyOwnBIBView Using Bl Blend Tables Altered 5/27/2021 10:35:18 PM

4 XFC Views
XFC_vMyOwnBIBView
XFC_vMIyView

» Views

o g 2 Rows page 1 of 1

TABLES | SELECT | JOIN | WHERE | SCRIPT ‘0

Available Tables Selected Tables for XFC_vMyView' View
BIB_MarketPlace_QA_62_BIBlend_Administrationimport_Actual_: XFC_MyFirstCustomTable

BIB_MarketPlace_QA_62_BIBlend_Administrationimport_Actual ¢ XFC_MySecondCustomTable

e o)
BIB_MarketPlace_QA_62_BIBlend_Administrationimport Actual ¢ Z

BIE_MarketPlace_QA_62_BIBlend_Administrationimport_Actual_: Add

BIB_MarketPlace_QA_62_BIBlend_Administrationimport_Actual ¢

BIB_MarketPlace_QA 62 BiBlend_Administrationimport_Actual ¢
BIB_MarketPlace_QA_62_BIBlend_Administrationimport_Actual_¢
BIB_MarketPlace_QA_62_BIBlend_Administrationimport_Actual_:

BIE_MarketPlace QA 62 BiBlend Administrationimport Actual.z .y

BIB_MarketPlace_QA_62_BIBlend_BaseWFimport_Blact_2018M1

BIB_MarketPlace_QA_62_BIBlend_BaseWFImport_BlAct_2018M1,

XFC_vBIB_MarketPlace_QA 62 BIBlend i port_A¢

Remove
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Using Table Data Manager

1. Select a database.

Click Define.

Click the Plus from the menu.

Click the Save.

7. Navigate to tabs below View Definitions.

8. Create and edit the definitions on each tab.

Views created in Table Data Manager have the prefix XFC.

Viewing a Schema

Select the View radio button. The view definitions are displayed on the right side.

Enter a view name and a view description for the view you want to edit.

You can see the schema for any table or view to help understand how it is constructed.

TABLE DATA MANAGER

HOME
Database Inspect Schema
Q 3 @ @ Schema (XFC_vBIB_Marketl

Define Schema Upload Download | Data Import Export Remove | Activity Statistics Drag a column header and drop it here to group by that column
BiBlendReporting_Web9 7 Column Name ¥ DataType ¥ Length ¥ Scale Y | Precision T
4 BiBlendReporting_Web9 Rt int 0 10

4 XFC Tables SourcelD nvarchar 250 0 0
XFC_MyFirstCustomTable Entity nvarchar 250 0 0
XFC_MySecondCustomTable EntityD nvarchar 250 0 0
KFC_vBIB_MarketPlace_QA_52_BIBlend_Administrationimport_Actual_2018M1 EntityND nvarchar 250 0 0

1. Select a database.
2. Select a table or view from the database.
3. Click Schema.
You can inspect the schema from the right side.
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Downloading a Schema

You can select an XFC table or view and download its schema to a file. This allows you to use files
in the upload process.

HOME

Database Inspect Schema

€ Q @7 @ & b B O | € &

Define Schema Upload Download Data Import Export Remove | Activity Statistics Drag a column header and drop it here to group |

BiBlendReporting_Web9 T Column Name ¥ | Data Type T | Length ¥ | Scal
4 BiBlendReporting_Web9 MyFirstColumn int
4 XFC Tables MySecondColumn | varchar AN
KFC_MyFirstCustomTable
KFC_MySecondCustomTable
» Tables
b XFC Views
b Views
@D Extensible Finance I =

Table "XFC_MyFirstCustomTable' downloaded to file
in the folder "Documents/Users/Administrator’.

oK

1. Select an XFC table or XFC view from the database.

2. Click Download. You will get a notification that the file has been created.

Uploading a Schema

You can upload a file containing metadata for an XFC table or view created from the download
process.
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TABLE DATA MANAGER
HOME

Database

9l N © | €
Define Schema Upload Download Data Import Export Remowve | Activity Statistics

BiBlendReporting_Webo v

4 BiBlendReporting_Web%
4 XFC Tables
XFC_MyFirstCustomTable
1. Click Upload. The File Explorer opens.
2. Select afile created during the download process.

3. Click Open to upload the file.

Inspecting Data

The Data button allows you to review some of the records and see what kind of data is coming

back from the table or view. You can select between 10-5,000 records for a sampling of the data

records.

Table Data Manager Guide
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Using Table Data Manager

TABLE DATA MANAGER O © @
HOME

Database Inspect Data /

gl @ @ Select Top Number of Records | 10 v

Define Schemaz Upload Download | Data Import Export Remove | Activity Statistics Data (XFC_vBIB_MarketPlace QA_62_BIBlend_Administrationimport Actual_2018M1) 7l

BiBlendReporting_Webg -
aga co eader and drop e to group by that co

4 BiBlendReporting Web9 Rt ¥ Sourceld ¥ Entity ¥ EntityD ¥ EntityMD ¥ Entityp ¥ Entityll ¥ | Entityle ¥ Entitys ¥ Cone

{ KFCTables ] RevenueMgmt Houston Houston | Houston Root 0 False 1 usD

XFC_MyFirstCustomTable 0 RevenueMgmt Houston Houston | Houston  Root 0 False 1 usp

XFC MySecandCustomTable ] RevenueMgmt Houston Houston | Houston Root ] False 1 usD

XFC_vBIB_MarketPlace_QA_62_BIBlend_Administrationimport_Actual_2018M1 0 RevenueMgmt Houston Houston | Houston Root 0 False 1 UsD

b= Tables ] RevenueMgmt Houston Houston | Houston Roat ] False 1 usD

- XFC Views 0 RevenueMgmt Houston Houston | Houston  Root 0 False 1 usp

XFCMyView ] RevenueMgmt Houston Houston | Houston Root ] False 1 usp

b Views ] RevenueMgmt Houston Houston | Houston Root 0 False 1 usD

0 RevenueMgmt Houston Houston  Houston Roat 0 False 1 usD

0 RevenueMgmt Houston Houston  Houston Roat 0 False 1 usD

1. Select a table or view from the database.
2. Click Data.

3. (Optional) Click an option (10, 100, 500, 1000, 5000) from Select Top Number of
Records to expand the data shown.

Exporting Data
You can only export the data records from an XFC table.

TABLE DATA MANAGER
HOME

Database

g © | €
Define Schema Upload Download Data Import Export Remowve | Activity Statistics

BiBlendReporting_Webg v

4 BiBlendReporting_Wehb?
4 XFC Tables
KFC_BIB_MarketPlace_QA_62_BIBlend_Administrationimport_Actual_2018M1_DimEt
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Using Table Data Manager

1. Select an XFC table from the database.

2. Click Export. The export file will be placed into the user's folder.

Importing Data

You can import data records to an XFC table using the file created during the export process. The
table chosen will need to be empty as the import process will not append or replace records. The
table names will need to match.

TABLE DATA MANAGER

HOME

Database Inspect Data

Q 3 @ @ Select Top Number of Records | 10 v

Define Schema Upload Download | Data Import Export Remove | Activity Statistics

BiBlendReporting_Webg v
P 9- Drag a column header and drop it here to group by that column

4 BiBlendReporting_Weh9
4 XFC Tables

XFC_MyFirstCustomTable
XFC_MySecondCustomTable
XFC_vBIB_MarketPlace_QA_62_BlBlend_Administrationimport_Actual_2018M1

1. Select an XFC table from the database.
2. Click Import. The file explorer opens.

3. Click Open to import the file into Table Data Manager.

Removing Data

You can remove data records only from XFC tables.
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Using Table Data Manager

TABLE DATA MANAGER

Database Inspect Data

Q 3 @ @ Select Top Number of Records | 10 v

Define Schema Upload Download | Data Import Export Remove | Activity Statistics

BiBlendReporting_Webs M
iendheporting_fie Drag a column header and drop it here to group by that column

4 BiBlendReporting_Webh9
4 XFC Tables

XFC_MyFirstCustomTable
XFC_MySecondCustomTable

XFC_vBIB_MarketPlace_QA_562_BlBlend_Administrationimport_Actuzl_2018M1

1. Select an XFC table from the database.
2. Click Remove. A confirmation prompt opens.

3. Click Continue to remove all data.

Reviewing Activity

You can review active transactions occurring in the database. This can be helpful to view the other
users within the database to see the current activity. Blocked transactions are transactions which
cannot complete because another transaction is blocking it. Use the Activity button to
troubleshoot this type of problem in your database.
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€ @

Activity  Statistics

Activity

Active Transactions 2l

Drag a column header and drop it here to group by that column

Session 1D T | Login Name Y  Begin Time T Last T-SQL Text
82 5/20/2021 1:42:35 PM  begin tran  update [OneStream_GoliStream_v44].[dbo]. [XFC_vStageRulesForGroup]  set [ExecutionOrder] = 0
83 1/1/1900 12:00:00 AM  begin tran  SELECT * FROM [OneStream_GolfStream_v44] [dbo].[XFC vStageRulesForGroup] --commit
20 1/1/1900 12:00:00 AM  begin tran SELECT * FROM [OneStream_Golfstream_v44].[dbo].[XFC_vStageRulesForGroup] --commit
21 1/1/1900 12:00:00 AM | begin tran SELECT * FROM [OneStream_GolfStream_v44].[dbo].[XFC_vStageRulesForGroup]  --commit
- r
Blocked Transactions &l

Drag a column header and drop it here to group by that column

session ID Y | Blocking Session 1D ¥ | Wait Time ¥ | wait Type Y Last Wait Type ¥ |
&1 23 00:00:02:197 | LCK_M_S LCK_M_S
23 22 00:00:04757  LCK_M_S LCK_M_S

1. Select a database.

2. Click the Activity button.

3. Review the activity in the Active Transactions and Blocked Transactions window.

4. (Optional) Diagnose and resolve issues as needed.
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Viewing Statistics

Statistics includes record counts for tables and views, plus Bl Blend specific information.

Records

You can display the record count for all tables and views in a database, for a particular table type
or view type, or individual table or view.

TABLE DATA MANAGER

Database Records

9 Q27 ¢ @8 no| € @|dJ E

Define Schema Upload Download | Data Import Export Remove | Activity Statistics | Records Bl Blend

BiBlendReporting_Webg M Record Count
4 BiBlendReporting Weh9 Drag a column  =ader and drop it here to group by that column
4 XFC Tables Schema Name ¥ | Name T
XFC_MyFirstCustomTable dho BI2_MarketPlace_QA_62_BIBlend_Administrationimport_Actual_2018M1
XFC_MySecondCustomTable dho BI2_MarketPlace_QA_62_BIBlend_Administrationimport_Actual_2018M1_DimAc
XFC_vBIB_MarketPlace_QA_62_BIBlend_Administrationimport_Actual 2018M1 dbo BI2_MarketPlace_QA_62_BIBlend_Administrationimport_Actual_2018M1_DimEt

1. Select a database, table type, view type, individual table, or individual view.
2. Click Statistics.

3. Click Records.

Bl Blend

If you are working with a Bl Blend database, you will see a Bl Blend button. This gives you the
same record count but also provides the processing information for Live Parameters,

WIP Parameters, and Processing Statistics. This extra information is only available on a
Bl Blend database.
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U oe

TABLE DATA MANAGER

HOME

Database Bl Blend

B a@ @ @bbo € @|d B <

Define Schema Upload Download | Data Import Export Remove | Activity Statistics | Records Bl Blend

giBlendReporting Webg N 5 8 Bl Blend Processing Information

Drag a column header and drop it here to group by that column

4 BiBlendReporting Web9

4 XFC Tables Bl Blend Warehouse ¥ Bl Blend Table T Map Errors Table v
XFC_MyFirstCustomTable BlelendReporting BI2_MarketPlace_QA_62_BIBlend_Administrationimport_Actual 2018M1 BIB_MarketPlace_QA_62_BIBlend_Administrationimport_Actual 2018M1_ME
XFC_MysecondCustomTable BlglendReporting BIB_MarketPlace_QA_62_BIBlend_BaseWFImport_BIAct_2018M1 BIB_MarketPlace_QA_62_BIBlend_BaseWFImport_BlAct_2018M1_ME
XFC_VBIB_] e_QA_62_BIBlend_ _Actual 2018M1

1. Select a Bl Blend database.
2. Click Statistics.
3. Click Bl Blend.
Creating a Table or Vie
You can create an XFC table or an XFC view on the database.
TABLE DATA MANAGER
HOME
Database Define Tables
- - 5 = & =i
B Q@ @ @ Bnho é a 62 i B
Define Schema Upload Download | Data Import Export Remove | Activity Statistics | Create Alter  Drop | Revive  Copy
BiBlendReporting_Webg v + O H | Table Definitions
4 BiBlendReporting Webd _Table Name Y Table Description A4
4 XFC Tables XFC_MyFirstCustomTable Table to hold custom data.
XFC_MyFirstCustomTable XFC_MySecondCustomTable Extra table to hold custom data
XFC_MySecondCustomTable XFC_vBIB_MarketPlace QA 62 BIBlend Administrationimport_Actual 2018M1
XFC_vBIB_MarketPlace_QA_62_BIBlend_Administrationimport_Actual_2018M1

1. Select a database.
2. Select Define.

3. Select the specific XFC table or XFC view from the respective Table Definitions grid.

4. Click Create.
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Altering a Table or View

Alter promotes changes made to XFC tables or XFC views during the define process onto the
database. The screenshot below shows the steps that correspond to the Altering a Table or

View procedure.

TABLE DATA MANAGER

HOME

Database

“Q@Q @ @
Define Schema Upload Download | Data

BiBlendReporting_Web9

DENGENG
p

Import Export Remove

vo

Activity Statistics

4 BiBlendReporting_Web?9
4 XFC Tables
XFC_MyFirstCustomTable
XFC_MySecondCustomTable

XFC_vBIB_MarketPlace_QA_62_BIBlend_Administrationimport_Actual_2018M1

1. Select a database.

2. Select Define.

Define Tables
N |—_h *
2 ®| 8 B

Create Alter  Drog | Revive Copy

+ = O H a Table Definitions

Table Name Y Table Description T
XFC_MyFirstCustomTable Table to held custom data,
XFC_MySecondCustomTable Extra table to hold custom data

XFC_vBIB_MarketPlace_QA_62_BIBlend_Administrationimport_Actual_2018M1

3. Make changes to the XFC table or XFC view.

4. Click Save to keep your changes.

5. Click Alter to promote saved changes to the database.

Dropping a Table or View

You can drop an XFC table or an XFC view from the database. Before dropping an XFC table
make sure all records have been removed using the Remove button.

Table Data Manager Guide
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TABLE DATA MANAGER

HOME

Database Define Tables

F@Q 2 @ @ @ R 0 € @ @z o B

Define Schema Upload Download | Data Impiﬂ Export Remove | Activity Statistics | Create Alter  Drop | Revive Copy

EiBlendReporting_Webo - + = O H | Table Definitions
4 BiBlendReporting Weh9 Table Name Y | Table Description T
4 XFC Tables XFC_MyFirstCustomTable Table to haold custom data.
XFC_MyFirstCustomTable XFC_MySecondCustomTable Extra table to hold custom data
XFC_MySecondCustomTable XFC_vBIB_MarketPlace_QA_62_BIBlend_Administrationimport_Actual_2018M1

XFC_vBIB_MarketPlace_QaA_52_BIElend_Administrationimport_Actual_2018M1
» Tables
b XFC Views

b Views

@ Drop table?

Drop "KFC_MyFirstCustomTable' table?

O=m -

1. Select a database.

2. Select the Define button.

3. Select the XFC table or XFC view definition record.
4. Click Drop.

5. Click Continue on the prompt.

Reviving a Table

You canrevive a table in Table Data Manager. This can be helpful if you lose track of changes
during design and need to reset in order to see the original table definition. You will see the table
in its original state in the designer.
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TABLE DATA MANAGER
HOME

Database Define Tables

@ Q7@ ¥ @ nolé @ 2 ®mn B

Define Schema Upload Download | Data Import Export Remove | Activity Statistics | Create Alter  Drop | Revive  Copy

BiBlendReporting_Webd v + = O
4 BiBlendReporting Web9 _Tab'e Nam
4 XFC Tables XFC_MyFirstCustomTable
XFC_MyFirstCustomTable XFC_MySecondCustomTable

1. Select a table from the database.
2. Click Define.

3. Click Revive. A prompt states that the table has been revived from the database.

Copying a Table

You can copy a table which was created using another database management tool into Table
Data Manager. This is helpful for allowing custom tables be managed by Table Data Manager.
Copying a table takes the schema and records from non-XFC table and copies them into an XFC
table. The screenshot below shows the steps that correspond to the Copying a Table procedure.

TABLE DATA MANAGER

HOME

Database Define Tables

3@@@2@@?{%0

Define Schema Upload Download Data Import Export Remove Activity  Statistics | Create  Alter Drop | Revive Copy

BiBlendReporting_Webg - + = DO H | Table Definitions
4 BiBlendReporting Web9 Table Name Y | Table Description ¥ Last Action Y | Last Change A
»  XFC Tables XFC_MyFirstCustomTable Table to hold custom data. Created 5/24/2021 8:45:40 PM
4 Tables XFC_MySecendCustomTable Extra table to hold custom data Created 5/24/2021 8:45:55 PM
BIE_MarketPlace_QA_62_BIBlend_Administrationimport_Actual_2018M1 e XFC_vBIB_MarketPlace_QA_62_BIBlend_Administrationimport_Actual_2018M1 Copied 5/25/2021 12:47:00 PM
BIB_MarketPlace_QA_62_BIBlend_Administrationimport_Actual_2018M1_Di
BIB_MarketPlace_QA_62_BIBlend_Administrationimport_Actual_2018M1_Di
BIB_MarketPlace_QA_62_BIBlend_Administrationimport_Actual_2018M1_Dil Accept or change name to be used for new table.
BIE_MarketPl 62_BIBlend_Administrationl rt_Actual_2018M1_Dil L
-MarketPlace 0A_62_BIBlend_Administrationimport_Actual =P YEC_ BIB_MarketPlace_QA_62_BIBlend_Administrat
BIB_MarketPlace_QA_62_BIBlend_Administrationimport_Actual_2018M1_Dii
BIB_MarketPlace_QA_62_BIBlend_Administrationimpart_Actual_2018M1_Dil 6 cancel 3 Ron
BIB_MarketPlace_QA_62_BIBlend_Administrationimport_Actual_2018M1_Fre¢
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—

. Select a database.

2. Click Define.

3. Selectanon-XFC table to copy.

4. Click Copy.

5. (Optional) Rename the table. The "XFC" prefix will automatically be appended.

6. Click Continue on the Copy prompt.
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Help and Miscellaneous
Information

71 | This page contains solution documentation.

Display Settings

OneStream and MarketPlace solutions frequently require the display of multiple data elements for
proper data entry and analysis. Therefore, the recommended screen resolution is a minimum of
1920 x 1080 for optimal rendering of forms and reports.

Additionally, OneStream recommends that you adjust the Windows System Display text setting to
100% and do not apply any Custom Scaling options.

MarketPlace Solution Modification
Considerations

A few cautions and considerations regarding modification of MarketPlace solutions:

« Major changes to business rules or custom tables within a MarketPlace solution will not be
supported through normal channels as the resulting solution is significantly different from
the core solution.

« If changes are made to any dashboard object or business rule, consider renaming it or
copying it to a new object first. This is important because if there is an upgrade to the
MarketPlace solution in the future and the customer applies the upgrade, this will overlay
and wipe out the changes. This also applies when updating any of the standard reports and
dashboards.

« If modifications are made to a MarketPlace solution, upgrading to later versions will be more
complex depending on the degree of customization. Simple changes such as changing a
logo or colors on a dashboard do not impact upgrades significantly. Making changes to the
custom database tables and business rules, which should be avoided, will make an
upgrade even more complicated.
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